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Limitation of Liability 

Multitronix LLC has exercised reasonable care in the design and manufacture of this product.  Each one 

is carefully tested prior to shipment.  However, the use or application of this product is beyond the 

control of Multitronix LLC and due to the nature of electronic devices, and the applications and 

environments applied to them, the possibility of failure or malfunction cannot be completely eliminated.  

Therefore, the buyer assumes all responsibility and uses this product at their own risk.  By using this 

product the user agrees to indemnify and hold harmless Multitronix LLC and its officers, agents and 

assigns from any and all liability, losses, damages, costs, claims, judgments, actions, and demands arising 

out of the use of this product, claimed on account of, or in any way predicated upon loss or damage to 

property, or injuries to or the death of any and all persons.   If you do not agree with this limitation of 

liability then do not use this product. 

 

 

 

 

 

 

 

Revision History 

Rev Date Description 

1.0    June 1, 2021 Initial Release 

 

The information in this document is subject to change without notice.   For the most recent version of 

this document visit:  www.multitronix.com 

 

 

 

Multitronix LLC reserves the right to change, improve or obsolete its products without prior notice. 

 

TelemetryPro® is a registered trademark of Multitronix LLC 
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GPS antenna 

(On the reverse side in this area) 

 

Keep metal, wires and other 

electronic devices well away from 

the GPS antenna! 

LED status indicators 

USB connector 

Antenna is not a handle!   

   Do not use it as one! 

POWER button 

Press and hold for two seconds 

to turn-on transmitter. 

Press and hold for six seconds 

to turn-off transmitter. 

Downlink antenna 

Keep metal, wires and other electronic 

devices well away from this antenna! 

WARNING:   Do not attempt to remove 

the downlink antenna.  The transmitter 

can be permanently damaged if it is 

powered-on without the antenna.  Do 

not operate the transmitter with a 

different antenna without written 

approval from Multitronix LLC. 

TelemetryPro®   Kate-3 Transmitter 
Model Mx210 Option-10 

 

   Transmitter ID code 

A unique three digit ID code 

number is pre-assigned to each 

transmitter.  Set the receiver to 

this same code number in order 

to link it to the transmitter. 
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1. The transmitter comes with a Li-ion battery already installed.   Never attempt to use a 

different type of battery other than the one Multitronix provides.  Doing so will run a 

significant risk of damaging the transmitter and possibly even starting a fire.     
 

2. The transmitter has a built-in charger.  Never attempt to charge the Multitronix supplied 

battery on a charger other than the one built into the transmitter.  Doing so runs a 

significant risk of fire danger.   The battery may get hot, catch fire or even explode.  
 

3. Discontinue use if the battery is ever damaged, leaks fluid, feels hot, has an odor or 

appears abnormal in any way.  
 

4. Do not charge the battery unattended.* 
 

5. Do not charge the battery if it has been damaged. 
 

6. Do not short circuit the battery. 
 

7. Do not disassemble or modify the battery. 
 

8. Do not allow the battery to get wet. 
 

9. Do not dispose of the battery in fire. 
 

 

 

 

 

* Never charge the battery unattended.   This is recommended just in case there has been some 

internal damage to the battery due to a hard landing or other flight anomaly.   If the battery 

gets hot while being charged then immediately stop charging it.   Replacement batteries are 

available from Multitronix. 

 

 

Safety Warnings 

Failure to observe these safety warnings may cause the battery to become 

hot, catch fire or explode and cause serious injury.  
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Recommended Mounting Scheme 

The transmitter is designed to be mounted inside a standard 54mm phenolic or fiberglass tube.   

Phenolic or fiberglass coupler tubes above and below it should be used to hold it in place within the 

main tube.   It must be mounted with the antenna facing up.  This is required for proper operation of 

the accelerometer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Maintain at least 1.5” 

spacing between the tip 

of the antenna and the 

nosecone metal tip. 

Red is 54mm coupler tube 

Blue is standard 54mm tube 

Capture aft bulkhead 

between the two lengths 

of coupler tube.   

Size both tubes so 

they rest against the 

inside surface of the 

nosecone.    

Nosecone aft bulkhead 

is held in place with 

screws or whatever 

works best in your 

situation.    

The lower section of 

coupler tube must be 

removable to allow 

transmitter to slide in 

and out for access. 

The upper section of 

coupler tube can be 

epoxied in place. 

WARNING: Do not use a carbon 

fiber nosecone or carbon fiber tubes.  

Carbon fiber will block the GPS signals 

and it will block the transmitted downlink 

signal!   Some fiberglass tubes that are 

black can also absorb the signal if they 

contain too much carbon or graphite to 

make them black. 
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Charging the Battery 

The transmitter has a battery charger built-in.  The charger only runs when the transmitter is off.   To 

charge the battery simply turn-off the transmitter and connect the USB to a computer or other 

dedicated USB charging device.   If a dedicated USB charging device is being used, it works best to first 

connect everything together and then plug the dedicated charger into a 120V outlet.     

1. The yellow “CHARGE” LED will be on when the battery is being charged.   

 

2. The green “CHG DONE” LED will be on when the battery is fully charged.  

 

3. The red “CHG FAIL” LED will come on if the battery failed to charge or took far longer to charge 

than expected.   

 

The battery will charge faster when the transmitter is connected to a dedicated USB charging device 

than to a computer.  This is because it can draw more power from a dedicated charger than from a 

computer USB port.   However, either way works fine.   Charging times vary a great deal depending on 

how low the battery was and how much power can be drawn over the USB.  Typical times range from 

one to four hours.    

To avoid damaging the battery, the charger will suspend charging (switch itself off) if the temperature of 

the battery is out of limit.  This will occur below 32°F and above 120°F.   Charging will automatically 

resume when the temperature returns within these limits.  

 

Caution 

Never charge the battery unattended.   This is recommended just in case there has been some internal 

damage to the battery due to a hard landing or other flight anomaly.   If the battery gets hot while being 

charged then immediately stop charging it.   Replacement batteries are available from Multitronix. 
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Turn-on Coil 

The transmitter can be turned-on by pressing the power button on it.  Press and hold the power 

button for two seconds to turn it on.  Press and hold the power button for six seconds to turn it 

off.  However, it can also be turned-on by passing a special induction coil around the outside of 

the nosecone.  This means the transmitter can be turned-on after already being installed into a 

nosecone.   

 

 

 

The turn-on coil generates a high frequency magnetic field that fills the entire loop area and is 

detected by a special circuit built into the transmitter.   

The turn-on coil has a green LED that indicates the battery voltage is good and that the unit is 

operating. The LED is extremely bright and can easily be seen in direct sunlight.  Do not stare 

directly into the green LED!   There is no power switch for the turn-on coil itself.  Just one silver 

button that powers it on and activates the coil.  

The turn-on coil can only power-on a transmitter.  It cannot power it off.   However, the 

transmitter can be powered-off remotely by selecting the “turn-off transmitter” menu option 

on the receiver. 

 

To turn-on the transmitter, press and hold the silver 

button on the turn-on coil while sliding the coil around 

the outside of the nosecone such that the tip of the 

nosecone passes through the middle of the coil.  Slide it 

somewhat slowly.  A few inches per second is ideal.   

The turn-on coil just needs to be approximately even 

with the top of the transmitter for just over one 

second.  Listen for a beep that will come from the 

transmitter when it powers up.  When you hear the 

beep, you can release the silver button.   

 

When the transmitter powers up, it generates a one 

second beep to let the user know.  It then beeps out its 

transmitter ID code and repeats that every so often in 

case it is needed for setting the receiver to the same 

code.  The beeping also serves as an audible "I am still 

alive" indicator. 

Turn-on Coil 

Model Mx105 
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Transmitter ID code 

The transmitter will only link with a receiver if they are both set to the same ID code.  ID codes 

are three digit numbers and are listed on the front of each transmitter.  Each transmitter is 

assigned a unique ID code at the factory so that there are no conflicts at a large launch where 

multiple TelemetryPro systems are being used at the same time. 

For convenience, the transmitter beeps out its ID code at regular intervals.  Each digit in the ID 

code is represented as a series of beeps.  There is a short delay in-between digits.  Beeping out 

the ID code is handy in case you cannot remember it after the transmitter has already been 

installed into a nosecone.  It also serves as an indicator that the transmitter is powered-on and 

is operating in flight mode.  

 

Example    If the transmitter ID code is 235 then the transmitter will beep twice for the first 

digit.  It will then pause with a short delay of silence and then beep three more times to 

represent the second digit.  It will pause again with another short delay and then beep five 

more times to represent the last digit.  If there is a zero in the ID code then that digit will be 

represented as a single longer beep. 

 

Multiple TelemetryPro systems can be on and running at the same time and they will not 

interfere with each other provided they use different ID codes.    

It is also possible to link up to four receivers to one transmitter if some tracking redundancy is 

desired.  In that case, the same ID code is used in all the receivers and must match the code 

used by the transmitter. 
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Establishing a Link 

When a transmitter and receiver are first turned-on, it should only take a couple of seconds for 

them to link-up.  The signal strength indicator in the upper right corner on the receiver display 

will be blinking LOS (Loss of Signal) until a link is established.  Once it is established, the signal 

strength indicator will show the strength as 0 to 5 bars.  “5 bars” represents the highest signal.   

If the link is ever lost, the two will automatically try to relink.  There is nothing the user needs to 

do other than make sure the receiver antenna is pointed at the transmitter if the transmitter is 

a long ways away. 

 

 

When the transmitter is in close proximity to the receiver (within 200 feet) then it is best to 

avoid pointing the receiver antenna directly at the transmitter.   This is because when the two 

are really close together the signal strength from the transmitter can overload the receiver and 

cause communications errors and dropped data packets.   In fact, they may not be able to stay 

linked or may also have trouble getting linked in the first place.  Overloading the receiver does 

not damage it.  It just causes the link to fail. 

If the link is not established within 30s then double check that you have set the receiver to the 

correct transmitter ID number.  Also try moving the receiver further away from the transmitter. 

It also helps to stand with your back to the transmitter while holding the receiver and pointing 

the antenna away from the transmitter because your body helps block and attenuate the 

signal.  

Once you are at a safe distance from the rocket and ready to launch then you should be able to 

point the antenna directly at the rocket.  In fact, it is very important to keep pointing it at the 

rocket during the entire flight!  It is easy to get distracted and forget to do this but pointing 

the antenna at the rocket during flight is important for optimum reception and longest range.    

 

 

 

 

 

Avoid Receiver Overload 
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Transmitter Power Setting 

The transmitter normally uses 100mW to transmit data packets while the rocket is still on the 

launch pad.  This is more than adequate for all but the most extreme situations.   Using only 

100mW reduces the drain on the battery and also helps avoid overloading the receiver when it 

is relatively close to the rocket.   At liftoff, the transmit power is automatically increased to 

500mW for the flight.   It will then eventually increase to 1 Watt based on altitude and distance.    

If a receiver needs to be more than a mile away from the launch pad, then it may be necessary 

to increase the 100mW transmit power in order to obtain a reliable link prior to liftoff.   In that 

case, the user can access the TRANSMIT POWER menu in the TelemetryPro Receiver and 

manually increase the power level to 500mW or even 1W if needed. 

The ability to increase the transmitter power while on the ground is also very useful for range 

testing to see how far the signal can be received after a transmitter has been configured and 

mounted in a rocket.  

The TelemetryPro Receiver User Manual has more information about adjusting the transmitter 

power.    
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Simulated Launch 

The TelemetryPro system includes a launch simulation mode that allows a user to simulate an 

entire flight.  This is used for training and practice so that a user can become familiar with 

operating the system prior to an actual launch.  The simulation is also a very good test to make 

sure the system is working properly.   

In simulation mode, the transmitter synthesizes telemetry data and sends it to the receiver.  

The receiver operates normally during a simulation.  It has no clue whether the data is real or 

synthesized! 

The TelemetryPro Receiver User Manual has more information on how to perform a simulated 

launch.    

 

 

Transmit Power for Simulated Launches 

A simulated launch can be used to test out the TelemetryPro system.  It can also be used to see 

if there are any compatibility issues with other onboard electronics.  However, the transmit 

power used during a simulation is normally just 100mW.  This helps avoid overloading the 

receiver when it is in close proximity to the transmitter.   If desired, the transmit power can be 

increased by accessing the TRANSMIT POWER menu in the TelemetryPro Receiver.   It allows 

simulations to be done with the transmitter running at 100mW, 500mW or 1W.  These can be 

used to make sure the other electronics will still function properly even while being subjected 

to the high power transmissions from the TelemetryPro transmitter.   The TelemetryPro 

Receiver User Manual has more information about setting the transmit power during a 

simulation. 
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Downloading Flight Data 

The transmitter saves flight data in flash memory and will retain that data even after it is turned 

off.   However, it only saves one flight.  The data will span from six seconds prior to liftoff and 

run for about one hour after liftoff unless the transmitter was turned off before then.  The 

Flight Data Analyzer program can be used to read the data from the transmitter. 

The latest version of the Flight Data Analyzer program can be downloaded from the Multitronix 

website.  Visit:   www.multitronix.com/software      

At this point, only Windows is supported.  XP, Vista, Win7, Win8 and Win10 should all work.    

Download and run the install package.  The install process does not make any changes to the 

Windows system or to the registry.  It simply creates a folder named "TelemetryPro" in your 

"Documents" directory.  It also puts a shortcut to the program on your desktop.  (To uninstall 

the program just delete the TelemetryPro folder and the shortcut.) 

 

Run the Flight Data Analyzer program and you should see a window like this: 

 

 

 

 

 

 

Before you can connect to the transmitter you must let the operating system 

install the appropriate drivers.   (See next page.)  It is recommended to leave 

the transmitter turned-off while Windows installs the USB drivers. 
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Installing USB Drivers 

The first time a transmitter is connected to a computer the USB drivers need to be installed.  

This should happen automatically.  It is best to leave the transmitter turned-off while Windows 

is installing the drivers.  This prevents Windows from misidentifying the transmitter as some 

other device.  The Windows operating system should automatically detect the transmitter as a 

new device and then search for and install the correct driver for your system.  The only thing 

you should have to do is let it run to completion.  Do not disconnect while it is still installing 

drivers.  The whole process will typically take about one or two minutes.  There are actually two 

separate drivers needed and Windows will automatically install both.  During this process you 

MAY see windows similar to those shown below.  (Windows-10 is so fast you probably will not 

see any pop-up windows. Just listen for the four note chime indicating the USB is ready to use.) 

 

 

 

 

 

Searching for the 

first driver. 

First driver 

installed okay. 

Searching for the 

second driver. 

Both drivers 

installed and 

ready to use. 
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Once the drivers have been installed, turn-on the transmitter and wait until the CONFIG LED is 

on.   Then press the CONNECT button on the Flight Data Analyzer window.   The analyzer will 

automatically search for the transmitter USB address and connect to it.  Once that happens the 

serial number of the transmitter will show up next to the button and the button will change to 

be a disconnect button.  See example below. 

 

 

 

 

 

 

Now press the “Read Flash” button to download all of the flight data.  (It is labeled as a Read 

Data button on newer versions of the software.)   It will take about five minutes to complete.   

 

 

 

 

 

 

You are now connected to the 

transmitter with this serial number. 
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A new window will pop up while the flight data is being downloaded.  It is shown below.  It 

allows you to enter some information about the flight.  It is the same kind of information 

usually put onto a flight card.  It will get saved along with the raw flight data in order to 

document the data.    

 

 

 

When the download has completed the “Done” button will become active.  When you have 

finished filling out the flight card information press “Done”. 
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After you click “Done” on the window with the flight card information, the program will begin 

processing the raw fight data and constructing a set of graphs.  This typically takes about 15 

seconds but may take a little longer depending on the speed of your computer.  Once the 

graphs are ready, a graph menu window will open that looks like the one below.  It shows all of 

the graphs that are available.  To view a larger version of an individual graph, click the “View” 

button below it.   

 

 

 

All of the graphs available in this menu are automatically included into the PDF fight summary 
report document.  That document can be viewed by clicking the PDF icon on the main window 
tool bar. 

 

 

 

Click the “View” button 
below each graph to 
open a new window 
showing a larger version 
of the graph. 
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Once the flight data has been processed, the program will automatically show a text window 
alongside the graph menu window.  The text window gives a summary of the flight and the key 
events that occurred during the flight.   An example is shown below.  Use the scroll bar on the 
right side to see all of the text. 

 

 

 

All of the information shown in this flight summary window is also included into the PDF fight 
summary report document.  That document can be viewed by clicking the PDF icon on the main 
window tool bar. 

 

 

 

Use this scroll bar to 
view the rest of the 
text in the flight 
summary window. 
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It is a good idea to save all of the flight data.  To do so, locate the main Flight Data Analyzer 

window and press the “Save Data” button. 

 

 

 

By default the flight data will get saved in your “Documents” directory in the 

TelemetryPro/FlightData folder.   However, you can easily change that when you save the data. 

There are five data files generated by this software:   

1. FlightData.bin  Raw Flight Data file. 

2. Analysis.pdf  Document that contains a summary and all the graphs. 

3. GoogleEarth.kml Google Earth flight trajectory file. 

4. Spreadsheet.csv Spreadsheet of all the raw data.  Opens in Excel for example. 

5. Summary.txt  A simple text file that contains the flight summary. 

You can open and view these files at a later time by using the File menu on the Flight Data 

Analyzer window to open the FlightData.bin file.   Or you can open any of the other files as 

desired. 
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You can view the flight trajectory in Google Earth by clicking on the Google Earth icon. 

   

 

 

Click on the Excel icon if you want to see the spreadsheet with all the raw data.  The graphs, 

flight summary page and full PDF flight report can also be opened by clicking on their icons. 

 

Explore the other capabilities of this program by opening up the menus on the tool bar.   
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Send Menu and Support/Help Feature 

There is another menu on the toolbar that is worth special mention here.  It is the “Send” 
menu.  It will allow you to send your flight data directly to Multitronix to be included into our 
growing archive of flights.  Doing so is completely optional but such information is very helpful 
for making future improvements to this software and to the TelemetryPro products.   Of 
course, you will need to be connected to the internet for this feature to work.   

You can also use the “Send” menu to simply ask questions or get support help from Multitronix 
even without sending any flight data.  And lastly, if you find a programming bug please report it 
using the “Send” menu if possible because it will send some additional debug information to 
Multitronix that may help figure out what is going wrong.   

 

Clicking “Send” on the tool bar will open another window that allows you to fill in the necessary 
information.   

 

 

Fill out the form and click this “Send” button to send the information directly to Multitronix. 
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Firmware Updates 

The Flight Data Analyzer program can be used to update the firmware in all TelemetryPro products.  The 
program will guide you through the process.  To begin the process, connect a USB cable to the device 
and press the “Connect” button to establish a connection.  Then click on the “Tools” drop-down menu 
and select “Update Firmware” as shown in the window below. 

 

 

 

 

 

Clicking “Open Browser” will open a page on the Multitronix website that allows you to download the 
latest firmware for your product.  Right click the download button on that web page and then select 
“Save target as…” to save the firmware file on your local hard drive.  Once it is saved on your local hard 
drive, click the “Select File” button on the window shown above.  Navigate to the file you saved and 
open it.  

Open the Tools drop-down menu. 

 

Clicking on “Update Firmware” will open a window like that shown 
below that makes it easy to get a firmware update file. 
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When you open a firmware update file a new window will appear that shows some information about 
the firmware.  It shows the version number of the firmware and the product it is built for.   You can also 
click on the “View Release Notes” button (optional) to see a description of all the features included into 
that version of firmware.  Click the “Start” button to begin the actual firmware update for your device. 

 

 

 

 

 

When the firmware update begins, a window will open that shows what is happening.  The firmware will 
be downloaded and verified.  The entire process takes about one minute to complete.   

 

 

 

It is important to not disturb the device while a firmware update is in progress.  Do not disconnect the 
USB cable and do not power-down the device.  Let the update process run to completion.  When it 
finishes another window will open as shown on the next page.   

 

Click on “View Release Notes” if you 
would like to see a description of all 
the changes included into this version 
of firmware. 

Click on the start button to begin updating your device.  

A progress bar shows what is 
happening during the update. 
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The device will automatically power itself off when the update process has completed programming the 
new firmware.   A “Firmware Reboot Required” window like the one shown below will then appear.  It 
explains what to do.  You just need to power-on the device, wait at least five seconds and then press the 
“Connect” button on the reboot window.   The new firmware will then begin executing and will be 
validated to confirm it was programmed correctly and is running properly. 

 

 

 

The firmware validation check will only take about one second to complete.  When it completes, a new 
window will appear that shows the firmware has been verified and is operating correctly.  

 

 

 

Click the “Done” button to close this window.  The firmware update process is complete!  Your device is 
now ready to be used.  

 

 

 

 

 

When the “Firmware Reboot Required” 
window appears you just need to 
power-on the device, wait at least five 
seconds and then press the “Connect” 
button.  This will start a validation 
check of the new firmware to verify it 
was programmed correctly. 
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Specifications 

PLEASE NOTE:  Recommended maximum acceleration during motor burn is 45 G’s.   This provides 

some headroom and operational margin within the accelerometer hardware limit of 50 G’s. 

 

Radio Link 
 ISM Band 902-928 MHz (USA)  or  915-928 MHz (Australia) 

 Spread spectrum frequency hopping with FSK modulation. 

 Maximum transmit power 1.0 W (30 dBm)   

 Typical transmit power used during flight is 500 mW  (27 dBm) 

 Downlink radio range: 550,000 feet  (100 miles)  

 Transmitter antenna:  2.5 dBi, 1/2 wave dipole, omnidirectional 

 Telemetry packets (binary format) transmitted every 200ms (Five per second) 

 Unique ID codes for transmitter and receiver pairing. 

 Two-way radio link.   Receiver can send commands to the transmitter.  

 FCC certified for unlicensed operation.   FCC ID:  MCQ-XBPSX 

GPS 
 Five GPS position fixes per second including altitude and velocity. 

 Unlimited GPS altitude reporting.   No altitude lockout. 

 GPS velocity lockout is 1700 feet/sec.    

 Active patch antenna, SAW filter, 15dB LNA. 

 GPS almanac retained while device is powered off. 

General 
 Size: 13.125 x 2.125 x 2.125 inches,  333 x 54 x 54 mm,  mounts inside 54mm coupler tube 

 Weight: 236 grams, 8.3 oz 

 50 G accelerometer recorded at 100 readings per second.   (See note at top of this page.) 

 GPS and accelerometer data are merged into one flight data stream. 

 Flight data is recorded in non-volatile flash memory.   

 Flight data recording time is from T-6 seconds to T+1 hour for a flight that is 30s to apogee. 

 32-bit RISC ARM Cortex-M4 CPU, 80 MHz 

 USB 2.0 compatible interface.  Mini-USB connector.  

 Wireless turn-on capability.  125 KHz magnetic field sensor.  

 Six LED status indicators:   
Flight Mode, Config Mode, USB Activity, Charging, Charge Done, Charge Failed 

 Onboard Li-ion 3.7V, 2.6Ah battery provides at least 3 hours of standby time prior to flight.   

 Built-in USB battery charger draws 900 ma on dedicated charger, 500 ma on standard USB port.   

 Charging time: 1 to 4 hours depending on battery discharge state and charger power source. 

 Battery charger operational temperature range:  0C to 50C, 32F to 122F 
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Dimensions 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mx210 Option-10 
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